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[bookmark: _Toc392692930]BACKGROUND
A.	[NOTE: Insert explanation of procedural posture of the case. To the extent applicable, the following language may be used.] The United States of America (“United States”), on behalf of the Administrator of the United States Environmental Protection Agency (EPA), filed a complaint in this matter pursuant to [insert causes of action and relief sought, e.g.: Sections 106 and 107 of the Comprehensive Environmental Response, Compensation, and Liability Act (CERCLA), as amended, [and Section 7003 of the Resource Conservation and Recovery Act (RCRA), as amended], seeking injunctive relief regarding the cleanup of the [insert site name] in [insert City, County, State] (“Site”), and recovery of costs incurred and to be incurred in responding to the release or threatened release of hazardous substances at or in connection with the Site].
B.	As a result of the release or threatened release of hazardous substances at the Site, EPA has undertaken response actions at or in connection with the Site under Section 104 of CERCLA, 42 U.S.C. § 9604 [and will undertake response actions in the future]. In performing these response actions, EPA has incurred [and will continue to incur] response costs at or in connection with the Site. [NOTE: Insert brief description of response actions undertaken at (or proposed for) the Site to date by EPA or private parties, noting whether a removal, remedial investigation/feasibility study, or record of decision has been completed. Describe briefly any previous settlements for performance of work or recovery of costs. Note whether further response action is planned.]
C.	The Regional Administrator of EPA, Region __, or his/her delegatee, has determined the following:
1.	Each Settling Defendant generated and/or transported only Municipal Solid Waste (MSW) and/or Municipal Sewage Sludge (MSS) to the [insert site name]; and
2.	Prompt settlement with each Settling Defendant is practicable and in the public interest.
D.	Based upon information provided by Settling Defendants and other relevant information, the United States estimates that Settling Defendants contributed MSW or MSS to the Site in the quantities shown in Appendix __.
E.	Settling Defendants do not admit any liability to the United States arising out of the transactions or occurrences alleged in the complaint.
F.	The United States and Settling Defendants agree, and this Court by entering this Consent Decree finds, that this Consent Decree has been negotiated by the Parties in good faith, that settlement of this matter without further litigation and without the [any further] admission or adjudication of any issue of fact or law is appropriate and will avoid prolonged and complicated litigation between the Parties, and that this Consent Decree is fair, reasonable, and in the public interest.
THEREFORE, with the consent of the Parties to this Consent Decree, it is ORDERED, ADJUDGED, and DECREED:
[bookmark: _Toc392692931]JURISDICTION
This Court has jurisdiction over the subject matter of this action pursuant to 28 U.S.C. §§ 1331 and 1345 and 42 U.S.C. §§ 9606, 9607, and 9613(b), and also has personal jurisdiction over Settling Defendants. Settling Defendants consent to and shall not challenge the terms of this Consent Decree or this Court’s jurisdiction to enter and enforce this Consent Decree.
[bookmark: _Toc392692932]PARTIES BOUND
This Consent Decree is binding upon the United States and upon Settling Defendants and their [heirs,] successors, and assigns. Any change in ownership or corporate or other legal status of a Settling Defendant, including but not limited to any transfer of assets or real or personal property, shall in no way alter such Settling Defendant’s responsibilities under this Consent Decree. 
[bookmark: _Toc392692933]DEFINITIONS
Unless otherwise expressly provided here, terms used in this Consent Decree that are defined in CERCLA or in regulations promulgated under CERCLA shall have the meaning assigned to them in the statute or regulations. Whenever the terms listed below are used in this Consent Decree, the following definitions shall apply: 
“CERCLA” shall mean the Comprehensive Environmental Response, Compensation, and Liability Act, as amended, 42 U.S.C. §§ 9601-9675.
“Consent Decree” or “Decree” shall mean this Consent Decree and all appendices attached hereto. In the event of conflict between this Consent Decree and any appendix, the Consent Decree shall control.
“Day” or “day” shall mean a calendar day. In computing any period of time under this Consent Decree, where the last day would fall on a Saturday, Sunday, or federal or State holiday, the period shall run until the close of business of the next working day.
“DOJ” shall mean the United States Department of Justice and its successor departments, agencies, or instrumentalities.
“Effective Date” shall mean the date upon which the approval of this Consent Decree is recorded on the Court’s docket.
“EPA” shall mean the United States Environmental Protection Agency.
“EPA Hazardous Substance Superfund” shall mean the Hazardous Substance Superfund established by the Internal Revenue Code, 26 U.S.C. § 9507.
“Interest” shall mean interest at the rate specified for interest on investments of the EPA Hazardous Substance Superfund established by 26 U.S.C. § 9507, compounded annually on October 1 of each year, in accordance with 42 U.S.C. § 9607(a). The applicable rate of interest shall be the rate in effect at the time the interest accrues. The rate of interest is subject to change on October 1 of each year. Rates are available online at http://www.epa.gov/ocfopage/finstatement/superfund/int_rate.htm.
“Municipal Solid Waste” or “MSW” shall mean waste material: (1) generated by a household (including a single or multifamily residence); or (2) generated by a commercial, industrial, or institutional entity, to the extent that the waste material (i) is essentially the same as waste normally generated by a household; (ii) is collected and disposed of with other municipal solid waste as part of normal municipal solid waste collection services; and (iii) contains a relative quantity of hazardous substances no greater than the relative quantity of hazardous substances contained in waste material generated by a typical single-family household.
“Municipal Sewage Sludge” or “MSS” shall mean any solid, semi-solid, or liquid residue removed during the treatment of municipal waste water or domestic sewage sludge, including sewage sludge containing residue removed during the treatment of wastewater from manufacturing or processing operations, if such residue has essentially the same characteristics as residue removed during the treatment of domestic sewage sludge.
“Paragraph” shall mean a portion of this Consent Decree identified by an Arabic numeral or an upper- or lower-case letter.
“Parties” shall mean the United States and the Settling Defendants.
“RCRA” shall mean the Solid Waste Disposal Act, as amended, 42 U.S.C. §§ 6901-6992 (also known as the Resource Conservation and Recovery Act).
“Record of Decision” or “ROD” shall mean the EPA Record of Decision relating to the Site signed on [insert date] by the Regional Administrator, EPA Region __, or delegatee, and all attachments thereto. [NOTE: Modify this definition to reference any ROD amendments or any Explanations of Significant Differences issued prior to the Effective Date.]
“Remedial Action” shall mean the remedial action selected in the ROD.
“Section” shall mean a portion of this Consent Decree identified by a Roman numeral.
“Settling Defendants” shall mean those persons, corporations, or other entities listed in Appendix A. [NOTE: Instead of listing the name of each Settling Defendant in Appendix A and the amount of payment by each Settling Defendant in Appendix C, Regions may choose to create one Appendix to serve both purposes.]
“Site” shall mean the ______ Superfund Site, encompassing approximately ___ acres, located at [insert address or description of location] in [insert City, County, State] and [insert either: “generally shown on the map attached as Appendix B” or “generally designated by the following property description: ______.”]
“[Site name] Special Account” shall mean the special account, within the EPA Hazardous Substance Superfund, established for the Site by EPA pursuant to Section 122(b)(3) of CERCLA, 42 U.S.C. § 9622(b)(3), and [if applicable, identify prior settlement under which EPA established the special account].
“State” shall mean the State [or Commonwealth] of ______.
“United States” shall mean the United States of America and each department, agency, and instrumentality of the United States, including EPA.
[bookmark: _Toc392692934]STATEMENT OF PURPOSE
[NOTE: As drafted, this Statement of Purpose assumes that all Settling Defendants are making a cash payment in exchange for a full and final settlement with the United States for all civil liability under CERCLA §§ 106 and 107 [and Section 7003 of RCRA] with respect to the Site as a whole. This Statement of Purpose will need to be amended if the settlement is of narrower scope with respect to some or all Settling Defendants. When using this or any other Statement of Purpose, be sure that it is consistent with the Covenants by United States, the Reservations of Rights by United States, and the definition of “matters addressed” in Paragraph 19.] 
By entering into this Consent Decree, the mutual objectives of the Parties are:
to reach a final settlement among the Parties with respect to the Site that allows Settling Defendants to make a cash payment to resolve their alleged civil liability under Sections 106 and 107 of CERCLA, 42 U.S.C. §§ 9606 and 9607, [and Section 7003 of the Resource Conservation and Recovery Act, 42 U.S.C. § 6973], for injunctive relief with regard to the Site and for response costs incurred and to be incurred at or in connection with the Site, thereby reducing litigation and simplifying any remaining administrative and judicial enforcement activities concerning the Site; and
to obtain settlement with Settling Defendants for their appropriate amount of response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, and by other responsible parties, and to provide for full and complete contribution protection for Settling Defendants with regard to the Site pursuant to Section 113(f)(2) of CERCLA, 42 U.S.C. §§ 9613(f)(2).
[bookmark: _Ref355770623][bookmark: _Toc392692935]PAYMENT
[bookmark: _Ref355771011]Within 30 days after the Effective Date, each Settling Defendant shall pay to the EPA Hazardous Substance Superfund [insert either: “the amount set forth below” or “the amount set forth in Appendix C to this Consent Decree”]. 
[bookmark: _Ref355770825]Each Settling Defendant shall make payment at https://www.pay.gov in accordance with instructions provided to Settling Defendants by the Financial Litigation Unit (FLU) of the United States Attorney’s Office for the District of ______ after the Effective Date. The payment instructions provided by the FLU will include a Consolidated Debt Collection System (CDCS) number, Site Name, Site/Spill ID Number ______, and DJ Number ______, which shall be used to identify all payments required to be made in accordance with this Consent Decree. The FLU will provide the payment instructions to:
[Insert name and email address of the individual who will be responsible for making the payment (if Settling Defendants are numerous, refer to attached Appendix)]

on behalf of each Settling Defendant. A Settling Defendant may change the individual to receive payment instructions on its behalf by providing written notice of such change to EPA and DOJ by  at: 

EPA:	[Insert Project Coordinator name and email address]          ]

DOJ:	eescdcopy.enrd@usdoj.gov

[NOTE ABOUT SPECIAL ACCOUNTS: The Decree should specify whether payments made under Paragraph 5 should be deposited in the EPA Hazardous Substance Superfund, or in a site-specific special account within the EPA Hazardous Substance Superfund, or should be split between the Superfund and the Special Account (and should specify the split).]
Deposit of Payment. [Insert one of the following three sentences here.] [The total amount to be paid pursuant to Paragraph 5 shall be deposited by EPA in the EPA Hazardous Substance Superfund.] [The total amount to be paid pursuant to Paragraph 5 shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] [Of the total amount to be paid pursuant to Paragraph 5, [“$___” or “___%”] shall be deposited by EPA in the EPA Hazardous Substance Superfund and [“$___” or “___%”] shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.]
Notice of Payment. At the time of payment, each Settling Defendant shall send notice that such payment has been made to EPA and DOJ by email at:

EPA: 	[Insert Project Coordinator name and email address] 

DOJ:	eescdcopy.enrd@usdoj.gov
	Re: DJ # ______

Each such notice shall reference the CDCS Number, Site Name, Site/Spill ID Number ______, and DJ Number ______.

[NOTE ON REQUIRING ONE COLLECTIVE PAYMENT: If the settlement involves a large number of Settling Defendants, it may be appropriate to include alternative instructions under which Settling Defendants are to establish a short-term trust or escrow account to receive their individual payments and to make one collective payment to the Superfund, using one of the payment approaches noted in Paragraph 6. In such event, the cost of the trust or escrow account may be funded from interest earned by the account or through other appropriate means.]

[NOTE: The following paragraph may be added if Settling Defendants will be making payment to a potentially responsible party (PRP)-managed trust fund or escrow account established pursuant to an existing settlement with EPA. If this paragraph is used, please add definitions for “Performing Parties” and “Performing Parties’ Response Costs” to the definitions section.]

Payment to Performing Parties. Within 30 days after the Effective Date, each Settling Defendant shall pay to Performing Parties $______, in payment of Performing Parties’ Response Costs. Payment shall be made to [insert instructions].
[bookmark: _Toc392692936]FAILURE TO MAKE PAYMENT 
 If any Settling Defendant fails to make full payment within the time required by Paragraph 5, that Settling Defendant shall pay Interest on the unpaid balance, which shall accrue from the Effective Date until the date of payment. In addition, if any Settling Defendant fails to make full payment as required by Paragraph 5, the United States may, in addition to any other available remedies or sanctions, bring an action against that Settling Defendant seeking injunctive relief to compel payment and/or seeking civil penalties under Section 122(l) of CERCLA, 42 U.S.C. § 9622(l), for failure to make timely payment. 
[bookmark: _Ref355770641][bookmark: _Toc392692937]COVENANTS BY UNITED STATES
[bookmark: _Ref355770757]Except as specifically provided in Section IX (Reservations of Rights by United States), the United States[footnoteRef:1] covenants not to sue or take administrative action against any of the Settling Defendants pursuant to Sections 106 or 107 of CERCLA, 42 U.S.C. §§ 9606 or 9607, [and Section 7003 of RCRA, 42 U.S.C. § 6973,][footnoteRef:2] relating to the Site. With respect to present and future liability, this covenant not to sue shall take effect for each Settling Defendant upon the Effective Date. With respect to each Settling Defendant, individually, this covenant not to sue is conditioned upon: (a) the satisfactory performance by Settling Defendant of all obligations under this Consent Decree; and (b) the veracity and completeness of the information provided to EPA by Settling Defendant relating to Settling Defendant’s involvement with the Site. This covenant not to sue extends only to Settling Defendants and does not extend to any other person.  [1:  If any agency other than EPA or DOJ, such as Coast Guard or Federal Emergency Management Agency, has or may incur response costs at the Site, such costs must either be addressed in the settlement or must be explicitly reserved in Paragraph 12.]  [2:  If including a RCRA § 7003 covenant, pursuant to Section 7003(d) of RCRA, you must offer to have a public meeting regarding the settlement and hold such a meeting if requested. To do this, please include language in the Federal Register notice providing for an opportunity for a public meeting in the affected area. For guidance regarding how to comply with this requirement, see “Revised Model Notice Language for Compliance with Public Participation Requirements of Section 7003(d) of RCRA” (Oct. 30, 1996) available at http://www2.epa.gov/enforcement/guidance-model-language-compliance-public-participation-requirements-under-rcra-section. ] 

[bookmark: _Ref355770598][bookmark: _Toc392692938]RESERVATIONS OF RIGHTS BY UNITED STATES
[bookmark: _Ref355773152]The United States reserves, and this Consent Decree is without prejudice to, all rights against Settling Defendants with respect to all matters not expressly included within Section VIII (Covenants by United States). Notwithstanding any other provision of this Consent Decree, the United States reserves all rights against Settling Defendants with respect to:
[bookmark: _Ref355771972]liability for failure to meet a requirement of this Consent Decree; 
[bookmark: _Ref355771982]criminal liability; 
liability for damages for injury to, destruction of, or loss of natural resources, and for the costs of any natural resource damage assessments;[footnoteRef:3]  [3:  The natural resource damages reservation must be included unless the federal natural resource trustee(s) has/have agreed to a covenant not to sue pursuant to Section 122(j)(2) of CERCLA. In accordance with Section 122(j)(1) of CERCLA, where the release or threatened release of any hazardous substance at the Site may have resulted in damages to natural resources under the trusteeship of the United States, the Region should notify the federal natural resource trustee(s) of the negotiations and encourage the trustee(s) to participate in the negotiations.] 

liability based on the ownership or operation of the Site by Settling Defendants; or
liability based on Settling Defendants’ transportation, treatment, storage, or disposal, or arrangement for transportation, treatment, storage, or disposal, of a hazardous substance or a solid waste at or in connection with the Site, after signature of this Consent Decree by Settling Defendants.
[bookmark: _Ref374455905]Notwithstanding any other provision in this Consent Decree, the United States reserves, and this Consent Decree is without prejudice to, the right to institute proceedings against any individual Settling Defendant in this action or in a new action or to issue an administrative order to any individual Settling Defendant seeking to compel that Settling Defendant to perform response actions relating to the Site, and/or to reimburse the United States for additional costs of response, if:
[bookmark: _Ref355771123]information previously unknown to EPA is discovered that indicates that such Settling Defendant contributed at least 10% more MSW or MSS than the amount indicated in Appendix A; or 
[bookmark: _Ref355771130]information previously unknown to EPA is discovered that indicates that such Settling Defendant contributed material containing hazardous substances to the Site other than MSW or MSS; or
[bookmark: _Ref355771139]conditions at the Site, previously unknown to EPA, are discovered, or information, previously unknown to EPA, is received, in whole or in part, and EPA determines that these previously unknown conditions or information, together with any other relevant information, indicate that the Remedial Action is not protective of human health or the environment, and that the conditions supporting the determination that the Remedial Action is not protective are based primarily on the presence of MSW or MSS at the Site.
For purposes of Paragraphs 13.a and13.b, the information known to EPA shall include only that information known to EPA as of the date the Consent Decree is entered. For purposes of Paragraph 13.c, the information and the conditions known to EPA shall include only that information and those conditions known to EPA as of the date the ROD was [“is”, for early settlements] signed, as set forth in the ROD and the administrative record supporting the ROD. [NOTE: If multiple RODs have been signed for the Site, consult with the Office of Site Remediation Enforcement as this paragraph (and the definition of ROD) will require redrafting.]
[bookmark: _Toc392692939][bookmark: _Ref395107877]COVENANTS BY SETTLING DEFENDANTS
Settling Defendants covenant not to sue and agree not to assert any claims or causes of action against the United States or its contractors or employees with respect to the Site or this Consent Decree including, but not limited to:
any direct or indirect claim for reimbursement from the EPA Hazardous Substance Superfund based on Sections 106(b)(2), 107, 111, 112, or 113 of CERCLA, 42 U.S.C. §§ 9606(b)(2), 9607, 9611, 9612, or 9613, or any other provision of law;
[bookmark: _Ref355773258]any claims arising out of response actions at or in connection with the Site, including any claim under the United States Constitution, the Constitution of the State [Commonwealth] of ______, the Tucker Act, 28 U.S.C. § 1491, the Equal Access to Justice Act, 28 U.S.C. § 2412, or at common law;[footnoteRef:4] and [4:  If the covenants by the United States in Paragraph 11 do not resolve Settling Defendants’ liability for the Site as a whole, the scope of Paragraphs 15.b and 15.c may be narrowed to conform to the scope of the United States’ covenants. For example, if the Consent Decree resolves Settling Defendants’ liability for defined “Past Response Costs” and for a defined “Operable Unit 1,” Paragraphs 15.b and 15.c could be limited to “any claim arising out of response actions at the Site for which the Past Response Costs were incurred and any claim arising out of Operable Unit 1.”] 

[bookmark: _Ref355773266]any claims pursuant to Sections 107 and 113 of CERCLA, 42 U.S.C. §§ 9607 and 9613, RCRA Section 7002(a), 42 U.S.C. § 6972(a), or state law regarding the Site.
Except as provided in Paragraph 17 (waiver of claims) and Paragraph 21 (waiver of claim-splitting defenses), these covenants shall not apply in the event the United States brings a cause of action or issues an order pursuant to any of the reservations set forth in Section IX (Reservations of Rights by United States), other than in Paragraph 12.a (liability for failure to meet a requirement of the Consent Decree) or 12.b (criminal liability), but only to the extent that Settling Defendants’ claims arise from the same response action, response costs, or damages that the United States is seeking pursuant to the applicable reservation.
Nothing in this Consent Decree shall be deemed to constitute approval or preauthorization of a claim within the meaning of Section 111 of CERCLA, 42 U.S.C. § 9611, or 40 C.F.R. 300.700(d).
[bookmark: _Ref355771942][bookmark: _Ref392689366]Settling Defendants agree not to assert any claims and to waive all claims or causes of action (including but not limited to claims or causes of action under Section 107(a) or 113 of CERCLA) that they may have for response costs [if natural resource damages (NRD) claims are being resolved through this settlement, insert: and for natural resource damages and assessment costs] relating to the Site against each other or any other person who is a potentially responsible party under CERCLA at the Site. This waiver shall not apply with respect to any defense, claim, or cause of action that a Settling Defendant may have against any person if such person asserts a claim or cause of action relating to the Site against such Settling Defendant. [NOTE: If a Settling Defendant asserts that it has a claim against a PRP within the scope of this waiver that is unrelated to the PRP’s CERCLA liability at the Site, e.g., a claim for contractual indemnification, add an exception for such claim such as the following: This waiver also shall not apply to Settling Defendant’s contractual indemnification claim against [insert name].]
[bookmark: _Toc392692940]EFFECT OF SETTLEMENT/CONTRIBUTION
Except as provided in Paragraph 17 (waiver of claims), nothing in this Consent Decree shall be construed to create any rights in, or grant any cause of action to, any person not a Party to this Consent Decree. Except as provided in Section X (Covenants by Settling Defendants), each of the Parties expressly reserves any and all rights (including, but not limited to, pursuant to Section 113 of CERCLA, 42 U.S.C. § 9613), defenses, claims, demands, and causes of action that each Party may have with respect to any matter, transaction, or occurrence relating in any way to the Site against any person not a Party hereto. Nothing in this Consent Decree diminishes the right of the United States, pursuant to Section 113(f)(2) and (3) of CERCLA, 42 U.S.C. § 9613(f)(2)-(3), to pursue any such persons to obtain additional response costs or response action and to enter into settlements that give rise to contribution protection pursuant to Section 113(f)(2). 	
[bookmark: _Ref355770812][bookmark: _Ref380409121]The Parties agree, and by entering this Consent Decree this Court finds, that this Consent Decree constitutes a judicially-approved settlement pursuant to which each Settling Defendant has, as of the Effective Date, resolved liability to the United States within the meaning of Section 113(f)(2) of CERCLA, 42 U.S.C. § 9613(f)(2), and is entitled, as of the Effective Date, to protection from contribution actions or claims as provided by Section 113(f)(2) of CERCLA, or as otherwise may be provided by law, for the “matters addressed” in this Consent Decree. The “matters addressed” in this Consent Decree are [all response actions taken or to be taken and all response costs incurred or to be incurred, at or in connection with the Site, by the United States or any other person.],[footnoteRef:5] except for the State;[footnoteRef:6] provided, however, that if the United States exercises rights under the reservations in Section IX (Reservations of Rights by United States), other than in Paragraph 12.a (liability for failure to meet a requirement of the Consent Decree) or 12.b (criminal liability), the “matters addressed” in this Consent Decree will no longer include those response costs or response actions [if the Decree includes an NRD settlement include: or natural resource damages] that are within the scope of the exercised reservation. [5:  This definition of “matters addressed” assumes that this Consent Decree is designed to resolve fully Settling Defendants’ liability at the Site. If the intended resolution of liability is narrower in scope, then the definition of “matters addressed” will need to be narrowed.]  [6:  If the State is a party and is resolving its claims regarding the Site through this settlement, delete “except for the State.” Note that State claims do not include claims for EPA Hazardous Substance Superfund costs that have been provided to the State through a cooperative agreement with EPA and for which EPA retains the responsibility for cost recovery.] 

The Parties further agree, and by entering this Consent Decree this Court finds, that the complaint filed by the United States in this action is a civil action within the meaning of Section 113(f)(1) of CERCLA, 42 U.S.C. § 9613(f)(1), and that this Consent Decree constitutes a judicially-approved settlement pursuant to which each Settling Defendant has, as of the Effective Date, resolved liability to the United States within the meaning of Section 13(f)(3)(B) of CERCLA, 42 U.S.C. § 9613(f)(3)(B). 
[bookmark: _Ref358014741]In any subsequent administrative or judicial proceeding initiated by the United States for injunctive relief, recovery of response costs, or other relief relating to the Site, Settling Defendants shall not assert, and may not maintain, any defense or claim based upon the principles of waiver, res judicata, collateral estoppel, issue preclusion, claim-splitting, or other defenses based upon any contention that the claims raised in the subsequent proceeding were or should have been brought in the instant action; provided, however, that nothing in this Paragraph affects the enforceability of the covenants set forth in Section VIII (Covenants by United States). 
Each Settling Defendant shall, with respect to any suit or claim brought by it for matters related to this Consent Decree, notify EPA and DOJ in writing no later than 60 days prior to the initiation of such suit or claim. Each Settling Defendant shall, with respect to any suit or claim brought against it for matters related to this Consent Decree, notify EPA and DOJ in writing within 10 days after service of the complaint or claim upon such Settling Defendant. In addition, each Settling Defendant shall notify EPA and DOJ within 10 days after service or receipt of any Motion for Summary Judgment and within 10 days after receipt of any order from a court setting a case for trial.
[bookmark: _Toc392692941]CERTIFICATION OF SETTLING DEFENDANT
By signing this Consent Decree, each Settling Defendant certifies, individually, that, to the best of its knowledge and belief, it: 
has conducted a thorough, comprehensive, good faith search for documents, and has fully and accurately disclosed to EPA all information currently in its possession, or in the possession of its officers, directors, employees, contractors, or agents, which relates in any way to the ownership, operation, or control of the Site, or to the ownership, possession, generation, treatment, transportation, storage, or disposal of any hazardous substance, pollutant, contaminant, or solid waste at or in connection with the Site; 
has not altered, mutilated, discarded, destroyed, or otherwise disposed of any records, reports, documents, or other information (including records, reports, documents, or other information in electronic form) (other than identical copies) relating to its potential liability regarding the Site since notification of potential liability by the United States or the State; and 
has and will fully comply with any and all EPA and State requests for information regarding the Site pursuant to Sections 104(e) and 122(e)(3)(B) of CERCLA, 42 U.S.C. §§ 9604(e) and 9622(e)(3)(B), Section 3007 of RCRA, 42 U.S.C. § 6927, and state law. 
[bookmark: _Toc392692942]RETENTION OF JURISDICTION
This Court shall retain jurisdiction over this matter for the purpose of interpreting and enforcing the terms of this Consent Decree. 
[bookmark: _Toc392692943]INTEGRATION/APPENDICES
This Consent Decree and its appendices constitute the final, complete, and exclusive agreement and understanding among the Parties with respect to the settlement embodied in this Consent Decree. The Parties acknowledge that there are no representations, agreements, or understandings relating to the settlement other than those expressly contained in this Consent Decree. The following appendices are attached and incorporated into this Consent Decree: 
“Appendix A” is [the list of Settling Defendants and the estimated quantities of MSW and/or MSS contributed by each to the Site].
“Appendix B” is [the map of the Site].
“Appendix C” is [the payment schedule].
[NOTE: List any additional appendices.]
[bookmark: _Toc392692944]LODGING AND OPPORTUNITY FOR PUBLIC COMMENT
This Consent Decree shall be lodged with the Court for a period of at least 30 days for public notice and comment. The United States reserves the right to withdraw or withhold its consent if comments regarding the Consent Decree disclose facts or considerations that indicate that this Consent Decree is inappropriate, improper, or inadequate. Settling Defendants consent to entry of this Consent Decree without further notice.
If for any reason this Court should decline to approve this Consent Decree in the form presented, this agreement is voidable at the sole discretion of any Party and the terms of the agreement may not be used as evidence in any litigation between the Parties.
[bookmark: _Toc392692945]SIGNATORIES/SERVICE
Each undersigned representative of a Settling Defendant to this Consent Decree and the [consult with DOJ attorney for appropriate official: Assistant Attorney General; or Chief/Deputy Chief, Environmental Enforcement Section], Environment and Natural Resources Division, United States Department of Justice certifies that he or she is fully authorized to enter into the terms and conditions of this Consent Decree and to execute and bind legally such party to this document.
Each Settling Defendant agrees not to oppose entry of this Consent Decree by this Court or to challenge any provision of this Consent Decree, unless the United States has notified Settling Defendants in writing that it no longer supports entry of the Consent Decree.
Each Settling Defendant shall identify, on the attached signature page, the name and address of an agent who is authorized to accept service of process by mail on behalf of that Party with respect to all matters arising under or relating to this Consent Decree. Settling Defendants hereby agree to accept service including, but not limited to, service of a summons, in that manner and to waive the formal service requirements set forth in Rule 4 of the Federal Rules of Civil Procedure and any applicable local rules of this Court. [Unless a complaint has already been filed and answered, insert: The Parties agree that Settling Defendants need not file an answer to the complaint in this action unless or until the Court expressly declines to enter this Consent Decree.]	
[bookmark: _Toc392692946]FINAL JUDGMENT
Upon entry of this Consent Decree by the Court, this Consent Decree shall constitute the final judgment between the United States and Settling Defendants. The Court [if this Consent Decree is a partial judgment, i.e., it resolves fewer than all the claims alleged in the complaint and/or the liability of fewer than all the parties named in the complaint, insert: finds that there is no just reason for delay and therefore] enters this judgment as a final judgment under Fed. R. Civ. P. 54 and 58.
 
SO ORDERED THIS         DAY OF                 , 20__.


_______________________________
United States District Judge




Signature Page for Consent Decree Regarding the ______ Superfund Site


FOR THE UNITED STATES OF AMERICA


Date:                			_____________________________________
					[NAME]
					[Chief/Deputy Chief]
					Environmental Enforcement Section
					Environment and Natural Resources Division
					U.S. Department of Justice
					P.O. Box 7611
					Washington, D.C. 20044-7601


					_____________________________________
					[NAME]
					Attorney
					Environmental Enforcement Section
					Environment and Natural Resources Division
					U.S. Department of Justice
					P.O. Box 7611
					Washington, DC 20044-7611


Signature Page for Consent Decree Regarding the ______ Superfund Site



					_________________________________
					[NAME]
					Regional Administrator, Region __
					U.S. Environmental Protection Agency
					 [Address] 


					_________________________________
					[NAME]
					Assistant Regional Counsel
					U.S. Environmental Protection Agency
					[Address]
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FOR ______________________________________:
						[Print name of Settling Defendant]


Date:                   			___________________________________________
					[Name and address of Settling Defendant’s signatory]


Agent Authorized to Accept Service on Behalf of Above-signed Party:

Name: ___________________ 

Title: ____________________

Address: __________________

[NOTE: A separate signature page must be signed by each settlor.]






Instructions Regarding Automated Features

	Feature
	Instructions

	Inserting text copied from a different document
	Text copied from a different document will usually have embedded formatting codes. Pasting the text into your document will cause the formatting codes to be inserted as well, which will create unpredictable and frustrating formatting and numbering results. Therefore, ALWAYS use the “Paste Special” function to insert text copied from another document. Press Ctrl-Alt-V; in the pop-up menu, click “Unformatted Text” and OK. (You can also click the Home tab, Paste, Paste Special, Unformatted Text and OK.)

	Inserting a new paragraph
	Click at the end of the ¶ immediately preceding the place where you wish to add the new paragraph, and press Enter. To change the new ¶'s outline level use (under the Home tab) the styles menu. For example, to change ¶12.b into ¶12.a(1), click in that ¶ and then (using the Home tab) click the "LVL 3" style. To change ¶13.a into ¶14, click in that ¶ and then (using the Home tab) click the  “LVL 1” Style. Note that in consent decree models, the letters denoting each background paragraph must be manually updated.

	Adding an updateable section or paragraph cross-reference
	(a) Click where you wish to insert a cross-reference; (b) Click the “References” tab, and, in the “Captions” box, click “Cross-reference;” (c) In the pop-up menu that appears, make sure the “Reference type” field contains “Numbered item” and the “Insert reference to” field contains “Paragraph Number (full context); (d) In the “For which numbered item” field” select the numbered item (section, paragraph. or subparagraph) you wish to cross-reference, and click Insert.

	Updating the cross-references
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Update Field;” click OK. Note: If a numbered paragraph that has been cross-referenced elsewhere in the document is deleted, remove the obsolete paragraph cross-reference. Otherwise, when you update the cross-references, the following message will appear: “Error! Reference source not found.”

	Updating the table of contents
	Right-click in the TOC, and in the pop-up menu, left-click “Update Field.” Or click in the TOC, press F9, click Update Entire Table and OK. If you have just added a new section heading, click Update entire table before pressing Enter.

	Inserting a new section heading
	Click in the text of the new heading and assign the “SECTION” paragraph style to the text by clicking the “Home” tab, and in Styles box, clicking the “SECTION” style button.) That will add the section number, change the numbering of later sections, and ensure that the new section will be referenced in the table of contents.

	Changing the font
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Font;” in the “font” field, select a new font; click OK.




